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Learn the Basics of Photoshop in Under 25 Minutes
 Adam Dachis — Photoshop is an incredibly powerful but also intimidating application. If you've 

wanted to start using Photoshop but didn't know where to start, we'll be teaching you the basics all week 
long.

The video above is your lesson. It's short considering how much it covers and long considering it's on the 
internet. In the video, we take a look at every tool in the toolbar, your palettes on the right side of the 
screen, and what you'll find in the menus. Below you'll find a reference for this lesson. Once the lessons are 
over, we'll provide everything all in one place and a downloadable PDF file containing references for each 
lesson.

Wait! I don't have Photoshop!

Are you not currently a Photoshop user? Adobe offers a Photoshop 30-day trial that you can download 
right now and it will provide you with plenty of time to learn how it works. If you don't want to eventually 
purchase Photoshop because it's too expensive, much of what we're going to discuss in these lessons will 
apply to not just to Photoshop but pretty much most of the standard photo-editing and design tools you'll 
find (Pixelmator is a great $30 alternative on the Mac, and GIMP is a free, open-source cross-platform 
option). We've chosen Photoshop because it's the most commonly used, but you're welcome to follow along 
using other software as well. Today's lesson is pretty Photoshop-specific, but as we move along you should 
be able to use other software to do most of what we discuss.

Ready? Let's get started.

The Toolbar
We're not going to take a look at every single tool but we are going to look at almost every one of them. 
While this overview will give you an idea of what each tool does, go find yourself a photo and start playing 
around with them.

Move Tool (Keyboard: V)

The move tool simply lets you move objects in a given layer around the Photoshop canvas. To use it, click 
anywhere on the canvas and drag. As you drag, the Photoshop layer will move with your mouse.
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Marquee (Keyboard: M)

The marquee lets you select part of the canvas in a specific shape. By default you get a rectangular (or 
perfect square if you hold down shift while selecting), but you can also select in the shape of an ellipse (or a 
perfect circle if you hold down shift while selecting).

Lasso (Keyboard: L)

The lasso is a free-form selection tool that lets you drag around the canvas and select anything the lasso'd 
area covers. Within this tool you also have access to the polygonal lasso, which lets you create a selection by 
clicking around on the canvas and creating points, and the magnetic lasso, which works the same as the 
regular lasso but attempts to detect edges for you and automatically snap to them.

Magic Wand (Keyboard: W)

Clicking an area with the magic wand will tell Photoshop to select the spot you clicked on and anything 
around it that's similar. This tool can be used as a crude way to remove backgrounds from photos.

Crop Tool (Keyboard: C)

The crop tool is used to (surprise!) crop your pictures. You can specify the exact size and constrain the crop 
tool to those proportions, or you can just crop to any size you please.



Eyedropper (Keyboard: I)

The eyedropper tool lets you click on any part of the canvas and sample the color at that exact point. The 
eyedropper will change your foreground color to whatever color it sampled from the canvas.

Healing Brush (Keyboard: J)

The healing brush lets you sample part of the photograph and use it to paint over another part. Once 
you're finished, Photoshop will examine surrounding areas and try to blend what you painted in with the 
rest of the picture.

Paintbrush and Pencil (Keyboard: B)

The paintbrush is a tool that emulates a paintbrush and the pencil is a tool that emulates a pencil. The 
paintbrush, however, can be set to many different kinds of brushes. You can paint with standard 
paintbrush and airbrush styles, or even paint with leaves and other shapes as well.

Clone Stamp (Keyboard: S)

Like the healing brush, the clone stamp lets you sample part of the photograph and use it to paint over 
another part. With the clone stamp, however, that's it. Photoshop doesn't do anything beyond painting one 
area over a new area.



History Brush (Keyboard: Y)

The history brush lets you paint back in time. Photoshop keeps track of all the moves you make (well, 50 by 
default) and the history brush lets you paint the past back into the current photo. Say you brightened up 
the entire photo but you wanted to make a certain area look like it did before you brightened it, you can 
take the history brush and paint that area to bring back the previous darkness.

Eraser Tool (Keyboard: E)

The erase tool is almost identical to the paintbrush, except it erases instead of paints.

Paint Can and Gradient Tools (Keyboard: G)

The paint can tool lets you fill in a specific area with the current foreground color. The gradient tool will, by 
default, create a gradient that blends the foreground and background tool (though you can load and 
create preset gradients as well, some of which use than two colors).

Blur, Sharpen, and Smudge Tools (Keyboard: None)

All three of these tools act like paintbrushes, but each has a different impact on your picture. The blur tool 
will blur the area where you paint, the sharpen tool will sharpen it, and the smudge tool will smudge the 
area all around the canvas. The smudge tool is very useful in drawing for creating nicely blended colors or 
for creating wisps and smoke that you can add to your photos.



Burn, Dodge, and Sponge Tools (Keyboard: O)

The burn, dodge, and sponge tools are paintbrush-like tools that manipulate light and color intensity. The 
burn tool can make areas in your photo darker. The dodge tool can make them lighter. The sponge tool can 
saturate or desaturate color in the area you paint with it. These are all very useful tools for photo touch 
ups.

Pen Tool (Keyboard: P)

The pen tool is used for drawing vector graphics. It can also be used to create paths that can be used for 
various things that we'll discuss in a later lesson (although if you watch the video you can see a type path 
being created).

Type Tool (Keyboard: T)

The type tool lets you type horizontally. Tools hidden beneath the horizontal type tool will let you type 
vertically and also create horizontal and vertical text masks.

Path Tool (Keyboard: A)

The path tool lets you move any created paths around. It's like the move tool, but for paths.
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Shape Tool (Keyboard: U)

The shape tool lets you create vector rectangles, rounded rectangles, circles, polygons, lines, and custom 
shapes. These tools are very useful when designing or when creating shape masks for photos.

3D Tools

These are the 3D tools. We're not going to be dealing with 3D stuff in these lessons so all you really need to 
know is that these exist. If you're curious, this video will give you an idea of what these tools can do.

Hand Tool (Keyboard: H)

The hand tool allows you to click and drag around the Photoshop canvas. If the entire canvas currently fits 
on the screen, this tool won't do anything. This tool is for easily navigating around when you're zoomed in, 
or a picture is simple too big to fit on the screen at 100%.

Zoom Tool (Keyboard: Z)

The zoom tool lets you zoom in and out of the Photoshop canvas by clicking on a given area. By default, the 
zoom tool only zooms in. To zoom out, hold down the option key and use the zoom tool as you normally 
would.
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Color Selection Tools (Keyboard: D for defaults, X to switch foreground and 
background colors)

These tools let you manage the colors you're using. The color on top is the foreground color and the color in 
back is the background color. The foreground color is what your brushes will use. The background color is 
what will be used if you delete something from the background or extend it (although now, Photoshop CS5 
will give you the option for using your foreground color instead in some circumstances). The two smaller 
icons up top are shortcut functions. The left one, showing a black square on a white square, will set your 
foreground and background colors to the defaults (Keyboard: D). The double-headed curved arrow will 
swap your foreground and background color (Keyboard: X). Clicking on either the foreground or 
background color will bring up a color picker so you can set them to precisely the color you want.

 

Palettes
Palettes are the things that you see sitting over on the right side of your screen. They make it easy for you to 
navigate through your document, add adjustments, switch modes, and other things.

Layers

The layers palette lets you see all the layers in your document. As you start getting to know Photoshop, 
you'll find yourself in this palette more than any other. It'll let you organize and arrange your layers, set 
blending modes, set visibility and opacity of layers, group and merge layers, and a bunch of other neat 
things we'll learn about in future lessons.
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Adjustments

Your adjustments panel is where you can easily create and edit adjustment layers. Adjustment layers are 
non-destructive image alterations that affect all the layers below them and can easily be turned on and off. 
Their most common use is for color correction (namely the Levels andCurves adjustments, but there are 
many different kinds of adjustments you can perform that can dramatically alter the look of your image.

Color Channels

The color channels palette will let you look at the specific colors that make up your picture. If you're in 
RGB mode you'll get red, green, and blue. These color channels will differ if you're in a different color space 
(such as CMYK or LAB). When you choose a specific color, you'll notice you'll be shown your image in 
different versions of black and white. This is because each color channel is simply a monochromatic images 
representing the light in each channel (e.g. the red channel is just a look at the red light in your photo). 
Switching between these different channels is useful for making color channel-specific touch ups, overall 
contrast enhancements, and also for converting your photo to black and white in a compelling way. This 
will be discussed in greater detail in a later lesson about color correction and photo enhancements.

Color Picker

This palette will let you easily alter your foreground and background colors using sliders.

Color Swatches

The color swatches palette is a set of pre-defined colors you can quickly choose from. You can load in 
several other pre-made swatch collections or create your own, too.
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History

The history palette lets you go back in time to undo any previous alterations. The standard undo command 
(in the edit menu) will simply toggle between undoing and redoing the latest action performed on your 
image. The history panel is where you can go back much further (50 actions by default).

Text

The text palette, and the paragraph palette below it, let you make all sorts of adjustments to any text you 
create with the type tool. These options are very similar to what you'll find in a word processing, but you 
can also specify things like character width and spacing which are more useful in design.

 

Menus

Most of what you'll find in Photoshop's menus can be found using the previously discussed tools. 
Nonetheless, we're going to take a quick look at some notable items in each of the menus.

 
File

File, as usual, handles opening, saving, and closing operations. Towards the end of these lessons we'll be 



taking a look at your different saving options (namely Save for Web).

Edit

Edit, as usual, brings you copy, cut, and paste. In Photoshop, it's also where you transform layers and set 
your color spaces.

Image

Image brings you canvas and image adjustments, including destructive effects that you'll also find in your 
adjustments palette. Options in this menu are designed to affect the image as a whole, although many 
adjustments are applied to only a single layer.

Layer

Layer lets you do all of the things you can do in the layer palette with a few more options. This menu also 
lets you create adjustment layers and smart objects (a group of layers treated as a single object).

Select

While the marquee and lasso tools will be your main means of selecting things, the select menu can help 
you refine that selection or create entirely new selections based on certain criteria (such as color range and 
luminosity).

Filter

Filter brings you a wealth of built-in (and, if installed, third-party) Photoshop filters that can blur, sharpen, 
distort, and alter your image (or layers of the image) in many different and unique ways. The best way to 
get acquainted with these filters is to try them all. That can take a little time, but it's fun to play around 
with them and see what they do. We'll be getting into the specifics in subsequent lessons, but only looking 
at a few commonly useful filters.

Analysis

Analysis provides you with measurement tools. There will be times when you need them to make accurate 
alterations to your images. We will not be covering anything in this menu in these basic lessons.

3D

As previously noted, we're not covering 3D. If you decide to learn more about 3D later, you may want to 
explore this menu on your own at some point.



View

View provides you with various view options, lets you hide and show line guides you've created (see video 
for an example), and make Photoshop snap (or not snap) to corners, edges, and to the grid on the canvas. 
Viewing of this invisible grid can also be turned on and off in the View menu.

Window

Window lets you hide and show certain windows and palettes. You can also arrange your Photoshop 
windows and palettes however you want and save them as a window preset.



Basics of Photoshop: Color Correction, Touch Ups, 
and Enhancements

 Adam Dachis — Now that you know the tools Photoshop has to offer, we're going to take a look at 
using them to correct and alter color, retouch blemishes and other unwanted parts of your photos, and 
enhance portraits to make the subject look especially good.

Welcome to the second lesson in our Basics of Photoshop series. The main lesson is the video above and the 
text below is for reference. Most of what you're going to learn here is best demonstrated in the video, so 
watching it is the best way to learn. In this lesson we're going to be covering three things: color correction, 
photo retouching, and photo enhancing. We're going to look at basic ways to perform these tasks and 
nothing too complex, but you'll find that these simple methods are very powerful and can handle the 
majority of what you'll want to do with your photos.

Color Correction
Color correction is a lot easier than you think. You just need to know which colors are complimentary 
(meaning on the opposite end of the color wheel) and you can use those to cancel out too much of another 
color. (If you need a refresher on color, check out our color guide.) You also need to be able to spot where 
colors are the most prominent. This means being able to tell, for example, when red is dominating the light 
areas of the photo and blue is dominating the dark areas. If you simple applied a blue filter to the entire 
photo, you'd end up with more neutral highlights—which you want—but a photo that looks too cool 
because the shadows are overly saturated with blue color. To recap, you need to pay attention to two major 
things when color correcting: which colors are dominating the photograph and which colors aren't, and 
also where, tonally, those dominating colors exist.

This is something you can generally do just by eying the photo, but the proper method is to consult the 
histogram. You can bring this up by going into the Window menu and choosing Histogram. The left side 
represents the shadows, the right side the highlights, leaving the middle for the midtones. If a particular 
color is dominating the photo in any area, you'll see it dominating that space on the histogram. This can be 
a handy guide for spotting necessary corrections.

Now that you've got a basic idea of what we're going to be targeting, let's take a look at some of the best 
color balancing tools Photoshop has to offer. You can find all the adjustments we'll be discussing in the 
following places:

You can find standard adjustments that apply to a single layer by going to the Image menu, choosing 
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Adjustments, then choosing the adjustment you want.

If you want to create an adjustment layer that can apply to multiple layers and be adjusted after the 
first application you can create an adjustment layer. You can either do this by going into the Layers 
menu, choosing Adjustment Layer, and then selecting the adjustment you want, or just selecting the 
adjustment you want from the Adjustments palette.

Color Balance

Color Balance is not a very flexible tool, but sometimes you just need minor adjustments to color and you 
can use Color Balance to apply them quickly. If the brightest parts of your photo are just a little bit too red
—something that's common with photos taken in low light—you can just select the Highlights radio button 
and then move the sliders towards cyan and blue a bit until you start to see the colors look a bit more 
balanced and neutral. You can also use Color Balance to create some interesting color effects by 
emphasizing different colors in the shadows, midtones, and highlights. Play around with it and get a feel 
for what it can do. It's not a tool you want to use most of the time, since Curves will generally help you do 
everything better and with more flexibility, but for quick changes Color Balance can definitely be useful.

Levels

Levels is like Curves (which we'll discuss next) with training wheels. You have three main sliders. On the 
left, you have the shadows slider. Moving it to the right will increase the intensity of the shadows. On the 
right, you have the highlights slider. Moving it to the left will increase the intensity of the highlights of your 
photo. In the middle, you have the midtones slider. Moving it to the left will brighten up your photo and 
moving it to the right will make it darker. These sliders mainly affect contrast. The sliders under Output 
Levels affect brightness. Moving the black slider towards the white one will brighten things up. Moving the 



white slider toward the black one will darken them. By default, Levels applies any of these changes to the 
entire photo, but you can select a specific color channel and alter it all by itself. There's a little drop-down 
menu at the top of the Levels panel that lets you select from all channels—I'm going to assume you're in the 
RGB colorspace and it says RGB—or each individual channel (red, green, and blue). If you want to 
brighten or darken just the reds, select the red channel and make your adjustments. To see a full 
demonstration of how Levels works, watch the video.

Curves

Curves is definitely the best color correction tool you've got in Photoshop, but you might find it a little 
intimidating and shy away from it since Levels seems to work well enough. Trust me—curves is much better, 
so take the time to get to know it and learn how it works so you're using it to do most of your adjustments. 
It's powerful, versatile, and very easy to control once you get the hang of it. That said, it works a lot like 
levels only you set your own points. You can adjust the entire image or just specific channels, just like you 
can in levels. To make a point on the curve, you just click anywhere on the line and drag in a particular 
direction. If you pull towards the top left corner, you'll brighten things up. If you pull down towards the 
bottom right corner, you'll darken things. The middle of the line in curves represents the midtones. The 
bottom of the line, touching the bottom left corner, represents the shadows. That would leave the top, 
which represents the highlights.

Here's an example of creating a simple curve: make a point at the midpoint of the line and then two more 
points that are each about one grid space away from the midpoint. Pull the bottom-most point down into 
the shadows a bit and the top-most point up into the highlights. This will create basic contrast and is the 
simplest adjustment you can make in curves. If you're having trouble understanding how this works, you 
can see an example in your Photoshop presets. At the top of the Curves window, you'll see a preset menu. 
Choose "Strong Contrast" and you'll get a curve that's similar to the one we just discussed. You should also 
check out the video at the top of this post to see a full demonstration of Curves.



Auto Tone

Sometimes you can just let Photoshop do a lot of the work for you. While you don't want to rely on 
Photoshop's Auto Tone option, you can just chose it from the Image menu to let Photoshop make an 
educated guess about what your photo needs in terms tone and color adjustments. Sometimes you can save 
yourself a little time by just using Auto Tone, but definitely don't rely on it. Sometimes it just gets it right 
and it takes about two seconds to try it out and see if it works. If it doesn't work, undo it, and do the 
corrections yourself. If it does work, you just saved yourself some time.

Photo Retouching and Enhancing
Basic photo retouching and enhancing is very easy and very effective if done with the right level of subtlety. 
We're going to take a look at some options for correcting problems in your photos—like cuts on a face, dry 
skin, dust from the lens, etc.—and also how to enhance a portrait to make it look especially nice.

Touch Ups
Most of the touch ups you're going to want to perform can be accomplished with the healing brush or the 
cloning stamp. If you're trying to just make a person look their best—which is all you really ought to be 
doing with a portrait—you can do most of what you want to do with the healing brush and clone stamp—
two tools wel discussed in a reasonable amount of detail in lesson one. We'll also take a brief look at some 
of your other options as well.

The Healing Brush Revisited

We've already discussed the healing brush quite a bit so we're not going to go over it in great detail here. 
Basically it works by selecting a source point (which you do by option-clicking an area of the photo) and 
painting over the area you want to "heal" with image data from the source point. The healing brush then 
uses its magic to blend in the painted source material with the stuff surrounding it. Generally this results in 
a more realistic result than you'd get with the Clone Stamp, but not always. The Clone Stamp works in the 
exact same fashion as the Healing Brush, but the Clone Stamp doesn't do any healing. All it does is replace 
the target area with whatever you selected as a source point. While you're technically cloning another part 
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of the photo and this may seem like it's going to look redundant, when you're correcting small areas it can 
sometimes look better than what the Healing Brush will give you—especially when you're near hard edges 
and areas of contrast. Both tools are best demonstrated visually, so be sure to watch the video if you're 
having trouble understanding how they work.

Other Tools

In addition to the Healing Brush and Clone Stamp, there are a few other ways to make corrections. If 
you're looking to reduce redness in certain parts of the skin, often times you can accomplish this by simply 
desaturating the red area a little bit. The Sponge Tool can help you easily desaturate a particular area. (If 
you've forgotten what the Sponge Tool is, refer back to lesson one.) If you're removing blemishes and want 
some alternatives, the Spot Healing Brush can sometimes be a little easier to use than the regular Healing 
Brush (you can find it by clicking and holding down the Healing Brush in the tool bar). It doesn't require 
you to set a source point. One last option is using Content-Aware Fill, which is a new feature in Photoshop 
CS5. To use it, what you want to remove needs to be in the background layer. Select the part you want to 
remove with a Marquee or Lasso tool and press delete. You should be presented with a dialogue box asking 
you what you want to do. If "Use:" isn't set to Content-Aware, change that and then press OK. Once you 
do, Photoshop will try to figure out what your photo should look like without that element. The more 
precise your selection is, the more successful Photoshop will be in replacing it. If you select something 
outside of the area you want to remove, it's possible that this will confuse Photoshop and you'll end up with 
unsatisfactory results. Generally you'll want to reserve Content-Aware Fill for removing items more 
prominent than blemishes, as the healing brush tools tend to do a better job at that, but it can do the job as 
well.

Enhancing a Portrait
Using a couple of minor enhancements, you can make a portrait look significantly better than the original 
photograph. Everything we're going to discuss here is designed to bring out the best in the image of the 
person you're working on and not necessarily look better than they actually do. Photos tend to pick up 
more detail than we'd normally notice and people generally don't have pimples, cuts, or other blemishes on 
their faces all the time. The idea is to bring out the best in the subject and not perform anything that's 
untrue to their appearance or is just downright unrealistic.

Color Channeling
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One of the best and easiest tricks to enhancing a portrait is making use if your color channels. You can find 
your color channels in the Channels palette on the right side of your screen. Assuming you're in the RGB 
color space, you'll see four options: RGB, red, green, and blue. RGB is the color image as you know it. The 
others are the respective channels. Click each of these and note their differences. You'll find that red has 
the most light, blue has the most detail, and green is kind of a combination of them both. When you're 
dealing with people, detail in skin is generally something you want to avoid and that's exactly what the red 
channel can help you do. Sometimes it's a near-perfect black and white photo all by itself, but if we're 
working with color it's still very useful. To make a nice adjustment, select the red channel, then select all 
(Command+A on a Mac, Control+A on a PC) and copy the image. Now switch back to the RGB combine 
channel, go back to your Layers palette, and paste the red channel. This will create a new layer on top of 
your background and you'll see only the red channel on your canvas. From the Layers palette, select a 
blending mode of Overlay for your red channel layer and reduce its opacity to somewhere between 20 and 
30 percent. As you're making this adjustment you'll see what a nice effect it can have (or you can just see 
this effect by watching the video associated with this lesson). This is one of the easiest adjustments to make 
and it's incredibly useful. It removes unwanted detail in the skin, adds contrast right where you want it, 
and often improves your photo's color as well.

Burning and Dodging

Burning and dodging can also be extremely useful when applying "virtual makeup" to your subject. This is 
something you'll want to do for men as well as women, because we're going to be very subtle and make it 
look as natural as possible. The idea is to place added contrast in the features of the face we want to 
emphasize: the eyes, nose, and mouth. You can use the burn tool to burn the midtones and shadows of the 
eyelashes and eyebrows, the curve of the nose, and the inner edges of the lips. You can use the dodge tool 
to brighten up the midtones of the colored and white parts of the eye and the inside of the lips. For a full 



demonstration, check out the video associated with this lesson. If you've forgotten how to use the burn and 
dodge tools, you'll see a proper demonstration in the video as well but you can also refer back to lesson one 
for additional reference.

While these enhancements are pretty minor, they make a significant difference in the overall look of the 
photo. While it might seem minor while you're making them, go into your History panel to see what the 
photo looked like in the beginning after you're done. Once you see the difference, you'll believe how these 
subtle little tricks can go a very long way.

-----

If you'd like to learn more about the topics we discussed today, be sure to check out our guide on getting 
the best color from your photos,give any photo the analog treatment, how to make your crappy photos look 
like they're awesome, and how to whiten teeth in your photos.
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Basics of Photoshop: Basic Drawing with the Pen 
Tool

 Adam Dachis — Photoshop isn't just for photos. In this lesson, we're going to take a look at 
Photoshop's ability to create vector graphics with the pen tool.

Learning to draw with the Pen Tool is one of those lessons that isn't very long but takes a bit of practice 
and, like most things with Photoshop, is best demonstrated visually. Be sure to watch the video to really get 
a grasp on how this works and use the text below for reference. If you'd like to look at the final product, 
you can download my drawing of Christine. It's a Photoshop CS5 file, so you'll need version CS5 to be able 
to open it.

That said, let's get started!

An Introduction to the Pen Tool
Photoshop's Pen Tool is very powerful but it can be deceiving. When you think of a pen, you think of 
pressing down and making a flowing mark with it. You don't generally think of a pen as a tool that creates 
dots on paper and automatically connects them in specific ways based on a number of factors. You don't 
because a pen can't do that in reality, but that's exactly what it does in Photoshop. While this may seem a 
little odd, it's a very powerful and useful method of drawing vector graphics.

The Pen Tool is actually a lot of tools in one, and we'll be looking at how to use most of them when 
drawing. The basic operation of the Pen Tool involves clicking around the Photoshop canvas to make 
points appear. These points will be connected by lines and start to create a shape. If you hold down the 
shift key before creating a point, it'll ensure this line is straight or forms a a perfect 45 degree angle 
(depending on where you attempt to place your next point). This is fine for drawing simple, rough shapes, 
but if we want curves and more unique shapes we need to do a little more work.
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Start off by creating a point on your canvas with the Pen Tool. Now create a second point, but don't let go. 
Hold down and drag and you'll see a curve start to appear. Holding down shift will create perfect angles 
and help you make a more even curve (if that's what you want). When you create points in this fashion, 
you'll see two lines flying out from the point. Those lines each have balls at the end, and if you drag those 
balls it affects one side of the curve. One line should already be touching the curve and one shouldn't. The 
line that's not touching the curve is the one that will have an affect on the next point you make. You can 
alter it immediately by holding down the option key while you're still dragging your curve into position. If 
you want to alter it after you've finished making your curve, you can also hold down the option key, click 
on the ball at the end of the line, and drag that ball where you want it. The longer the line, the more 
restrictive it will be on your next curve. The angle it creates will also have a dramatic effect on the curve. 
Smaller angles will help you create sharper edges. Wider angles will help you create rounder ones. Go 
ahead and give it a try to get an idea of how things work and be sure to watch the video to see a 
demonstration. You'll pick it up the Pen Tool much faster by watching it in action.

If you're having trouble getting the pen tool to do what you want, one thing that can help is the grid. You 
can turn on the grid by going to the View menu menu and choosing Grid from the Show submenu. 
(Command ' on Mac and Control ' on Windows will also do the trick.) The grid can make it a lot easier to 
see what you're doing and snap to the right points. Try using it while drawing an easy shape like a heart. 
The grid makes those kinds of shapes much easier to draw.

Practice, Practice, Practice
It's hard to get a grasp on the Pen Tool at first because it's awkward, so you have to practice. The easiest 
way to practice is to trace photos. Silhouettes are excellent starting points because you're only dealing with 
one color. Once you're able to get your stroke and shape the way you want it, you can move on to doing 
more complex drawings like the one created in the video associated with this lesson.



That's all for today. Tomorrow we're going to look at web design and layout, and then we'll wrap things up 
on Friday with a recap, your next steps in your Photoshop education, and what great online and offline 
resources are at your disposal.



Basics of Photoshop: Designing a Website
 Adam Dachis — For our last lesson, we're going to take a look at how to use Photoshop to layout and 

mock up a web design from scratch.

If there ever was a Photoshop lesson that required the video component, it's this one. In this lesson we look 
at using the Shape and Text tools to create a website design from scratch. None of these concepts can really 
be written out, so there is very little accompanying text with this lesson. You've already learned most of the 
tools in previous lessons and so this one just shows you how to put them to use to create a site. There are a 
few new things to discuss, however, and they're addressed below.

If you'd like to follow along in the video or see what the final product looks like in Photoshop, you can 
download the site design file and assets here. This is a good way to explore and see how things work. The 
files were created in Photoshop CS5 so you'll need that to view them.

Using Guides

Guides are little blue horizontal and vertical lines in Photoshop that help you align things on the canvas. 
You can make them by turning on rulers (Command + R on a Mac or Control + R on Windows), clicking 
on the ruler, and then dragging the line down on to your page. To later adjust any guides you create, use 
the Move tool (V on your keyboard) at the top of the toolbar.

Creating Shapes

We've looked at creating shapes before, but you'll find here that shapes are especially vital to your layout. 
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Because they're vector images (rather than raster), they can be resized without getting pixelated. This can 
be really helpful when you're laying things out but you might want to make changes later. You're almost 
always better off keeping everything in your mockups vector-based, unless it's something that can't be 
vector-based (like a photo).

Organization

Organizing your website mockups is very, very important. You'll find yourself creating tons and tons of 
layers, so you want to keep naming those layers and grouping them together as frequently as possible. The 
more effort you put into organizing your layers, the easier it will be to navigate through your design later. 
This is especially helpful to developers who may be getting your designs later on. If they have to go through 
and search for elements, you'll be making their lives much more difficult. Angry developers are unpleasant 
(I've been one and worked with several). Start off that relationship on a good note by providing a nicely 
organized document. It's for your own benefit, too, so everybody wins.

Saving for Web

Whether you're the developer or not, someone's going to need to create web-friendly versions of the images 
used in your design. Nowadays a lot of effects and styles can be created with CSS and JavaScript, so you 
don't need to worry about too many things. If you have a persistent logo, for example, you'll need to save 
that for web. While there are a lot of ways you can go about this, the easiest thing to do is just copy the 



layer that holds the graphic, paste it into a new document, and then initiate the save for web process. You 
can find "Save for Web & Devices..." in the File menu. When you bring that up, you'll get a big new window 
that previous what your graphic will look like after it has been compressed using the settings you provide. 
Generally "JPEG - High" or "PNG 24" are good choices, depending on the graphic. If the graphic is very 
simple in color and tone, or if you need a transparent background, 24-bit PNG files are the format you 
want. If you have a more complex graphic, "JPEG - High" is generally the best setting. You can fool around 
with the compression amount and other settings until you get what you want, but you'll be served well 
enough by sticking to that preset. Once you click Save you'll be able to name the file. You don't have to 
worry about naming it safely for the web. One nice thing that Photoshop does for you is add hyphens in 
place of spaces so you have a web-safe file name when you're done.

That wraps up our Basics of Photoshop series. Tomorrow we'll do a little recap and then provide some 
additional resources, but you're all done with your lessons—congratulations! Hopefully now you can start 
using Photoshop to make your photos better, draw some cool pictures, and make a web site to show off 
your work.



Basics of Photoshop: Next Steps 
and Further Resources

 Adam Dachis — You've learned the basics of Photoshop, but 
now what? Before we call it quits, let's take a look at the next steps 
you can take in furthering your Photoshop education and some 
resources that'll help you along the way.

Despite everything we've covered, Photoshop is such a versatile 
application that there's still a lot to learn. We've actually posted a 
lot about Photoshop and have a few additional resources of our 
own to help you learn how things work. Additionally, we've pulled 
together some online and offline resources to help you learn just 
about anything else the application can do.

Note: These are not sponsored recommendations even though 
offline resources go to Amazon product pages and some of the 
online resources cost money. We just wanted you to know there's 
nothing in it for us and these are just resource we actually like. If 
you've got some suggestions of your own, please share them in the 
comments.

More Lifehacker Photoshop Lessons
How to Get the Best Color Out of Your Photos

A Beginner's Guide to Image Sharpening

How to Whiten Teeth in Your Photos
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How to Change a Specific Color in a Photo

How to Make Your Smartphone Photos Look Like They Were 
Taken with a Nicer Camera

How to Give Any Photo the Analog Camera Treatment

Get Better Black and White Conversions from Your Shots

Create Seamless Textures in Photoshop

Stitch Pictures Together with Photoshop's Photomerge Tool

Improve Photographs Taken from Airplanes

Add Custom Reflections in Photoshop

Sharpen Your Digital Photos with the Unsharp Mask

Online Resources
National Association of Photoshop Professionals - NAPP is a 
membership-based service that provides its members with 
some very helpful services. First, you get their magazine each 
month (Photoshop User), and it will teach you some great new 
Photoshop tricks. You'll also have access to the NAPP help 
desk, which is a place you can ask questions when you have 
trouble with Photoshop (or just want to learn how to do 
something), and many online video tutorials. These are just a 
couple of benefits of NAPP. Go check it out to learn more.

Lynda - Lynda is an online training library that has tons and 
tons of videos. It costs you around $30 a month for access, but 
if you just want to learn a couple of things you can generally 
fit them into a single month and then cancel your membership 
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(which can be later renewed). They have tons of lessons about 
Photoshop that'll teach you things you didn't even know it 
could do. There's so much to learn and they have all of it 
covered. While you can learn a lot for free online, Lynda is 
probably the best resource for Adobe-related learning.

You Suck at Photoshop - This is one of the most entertaining 
ways to learn some new Photoshop tricks, and it's free. You 
Suck at Photoshop won't teach you more than a handful of 
specific things, but it is funny and you'll actually learn the 
techniques that are explained—many of which you'll use 
again.

Adobe: Learn Photoshop CS5 - Adobe provides some 
resources of their own that cover a lot of basic things we 
glossed over. If you want to learn more about HDR, Camera 
RAW, new features in CS5, etc., this is a good place to start.

PSDTUTS+ - Like most tutorial sites, PSDTUTS+ cover al ot of 
tips and tricks rather than a full series on what to do. You'll 
want to bookmark this site to keep an eye out for tutorials that 
interest you. It's a good way to learn little tricks you'll be able 
to repurpose and reuse later. Tutorial9 and Photoshop Lady 
are also good, similar options.

Offline Resources
Books by Scott Kelby - Scott Kelby created NAPP (mentioned 
above) and has a ton of books and videos. He's been teaching 
Photoshop for quite awhile and knows what he's talking 
about, and his books tend to specialize in different areas of 
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Photoshop so you can concentrate on the skills you actually 
want.

Adobe Photoshop CS5 One-on-One - Deke McClelland is 
another name you'll hear often in the Photoshop learning 
community. He has lessons available on the previously 
mentioned Lynda.com, but you can also get his book if you 
prefer to learn offline.
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